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Introduction

Pure360 have worked with Apteco for integrating the FastStats platform into PureResponse. The purpose was to create a 
seamless process for users of both systems, allowing them to send highly personalised email campaigns to targeted lists 
and receive real-time event notifications on campaign activity.   

PureResponse integrates with FastStats through SOAP/XML and traditional HTTP/S protocols for secure, near real-time 
campaign delivery, monitoring and response capabilities.

The tools built into the FastStats platform address a variety of email marketing needs: An individual communication can 
be created using wizards in the FastStats platform that send the following to PureResponse in sequence:

Upload a recipient list
Schedule a campaign 
Retrieve event notifications
Update appropriate Client records

For more complex campaign needs, FastStats provides the Cascade module, which allows control and management of 
multiple ongoing promotions and campaigns, feeding appropriate response data to the FastStats system allowing for 
comprehensive, near real-time market analysis. In combination with the PeopleStage module, workflow management 
and process flow diagrams can be implemented. This allows a marketer to react to audience responses in an appropriate 
fashion using verifiable, accurate and targeted business data. 

Pure360 offers a closed loop integration with FastStats. You can push campaign data directly from your instance of 
FastStats into the relevant Pure360 account. This can be done on an ad-hoc basis or regular updates can be scheduled 
based on predefined queries using the Cascade module. This unique closed loop environment enables us to feed back in 
near real time the activities of your recipients.You can then query on email activity as well as existing data, adding value 
and providing more targeted communications. 

An example of this could be a query of all subscribers who subscribe to a particular publication from your company who 
have opened 5 of the last 6 emails. This would indicate a propensity to interact with and add value to their subscription.
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How a campaign is conducted

To help understand how the process works, the diagram below shows the transition of information from FastStats to 
customer and back through PureResponse.

A broadcast campaign is started in FastStats via the Email Broadcasting Wizard which creates an entry in the Web Service 
database (typically known as WS_DB)

The FastStats service uploads the selected list to PureResponse via an HTTP post method and waits for notification that this 
has completed successfully (it should be noted that upload times will vary based on volume of data and activity taking place 
on the PureResponse platform).

Once notification that the list has been processed has been received from the PureResponse platform, the campaign is 
scheduled on the system using either a requested name or, if provided earlier that name. The PureResponse platform now 
conducts the campaign as requested using the details provided during the scheduling process in FastStats and starts collating 
responses to be fed back.

The Email Response Gatherer application within FastStats collects all Event Notifications from PureResponse, using its agreed 
schedule, recording these Event Notifications in the Response database (typically known as the RS_DB).

Analysis of this data can now take place in the FastStats system from which reports can be generated. 

For example, you may conduct an initial campaign introducing a new product or service to your customer base. The results of 
this can then be analysed to see who has engaged with the campaign to date, and optimise your future deliveries accordingly 
(removing those who have resulted in hard bounces, re-targeting those who soft bounced, getting further interaction with 
those who have opened or clicked on links within the email to engage them further in the product or service).
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Configuring the integration with PureResponse

CREATE THE RESPONSE DATABASE (RS_DB)

To store data returning from PureResponse you will need a Response Database. This will be used to receive your responses 
from the PureResponse platform and needs to be created first. In order to create this, open the FastStats Configuration 
application and click on the Database Management button.

The Database Management dialog box is now displayed. You now need to connect to the Server where the Response 
Database will be stored. Choose the Database type from the Database dropdown and select the Server from the Server 
dropdown. If required, tick the box marked Connect using SQL Server username and password and provide these in the 
two text boxes provided below the tick box, then click the Connect button. In the Run SQL Script section below this, 
select Create Response Database from the Choose script to run dropdown, giving a name to the database where you 
are going to store the Event Notifications provided by PureResponse (for example, you may choose to call this database 
PureResponse_Results). If not using the Default location, untick the Use default location tick box and provide the
necessary locations either by typing them manually or clicking the appropriate Browse buttons. When you are 
satisfied with your selections, click Run Script.

SETTING UP THE EMAIL RESPONSE GATHERER

The PureResponse platform provides two delivery mechanisms for collecting Event Notifications. The first and typically most 
popular is for the Email Response Gatherer application in FastStats to regularly collect outstanding Event Notifications with 
a batch file. The second uses the Email Response Web Service which enables the PureRepsonse platform to send Event 
Notifications to a provided URL. Again, it should be noted that delays can occur because of latency in the network and 
demand on the PureResponse platform.

INSTALLING THE EMAIL RESPONSE GATHERER

You will find the Email Response Gatherer application installation package in the DigitalIntegration.zip file provided with 
FastStats. This should be downloaded from the Downloads Area to a folder on the server where the Email Response 
Gatherer will be installed on.

Extract the file EmailResponseGathererSetup.msi file from the DigitalIntegration\ EmailResponseGatherer folder. Launch 
the software by double clicking on it.

PTO to see example...
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Click the Next> button. On the following screen, use the 
Browse… button to navigate to the location where you wish 
to install the Email Response Gatherer application and click 
the Next> Button.

On completion you are presented with the following screen. 

The installation has now completed, so click on the 
Close button.
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CONFIGURING THE EMAIL RESPONSE GATHERER PRIOR TO LAUNCH

You now need to navigate to the directory where the Email Response Gatherer has been installed.Unless you changed the 
directory during the installation process, this can be found at:

C:\Program Files\Apteco\FastStats Email Response Gatherer. Inside this folder are a number of files, but the one we are 
interested in is the EmailResponseGatherer.exe.config file. Open this in Notepad or any other plain Text Editor.

The <appSettings> section contains the information that we need to change. Scroll down to this section and change the key 
db_connection_digitalresponse value for Initial Catalog indicating where you created the response database earlier, in the 
Creating Response Database phase. 

Note: if you changed the database location and database log location earlier, you will need to provide these details too. So 
for example, our entry might look like this: 

<appSettings>
 <add key=”db_connection_digitalresponse” value=”Data Source=db_server;Initial 
Catalog=PureResponse_Results;User Id=faststats_service;Password=fa5t5tat5!;”/>
</appSettings>

Save the settings and exit your editor.

STARTING THE EMAIL RESPONSE GATHERER

The Email Response Gatherer tool is now ready to be started. Typically this is done from the command line. An example 
command line to launch the Email Response Gatherer could be as follows:

EmailResponseGatherer Pure360 
<<profile>>\<<username>><<password>>”Secure=false;EMAILCOLUMNNAME=email;URNC
OLUMNNAME=Person_ID;ADDITIONALCOLUMNNAMES=Forename,Surname,PackCode,device 
type,deviceOS,device Browser;”

The elements shown above in Italics (i.e. <<profile>>, <<username>> and <<password>>) will have been provided by Pure360 
allowing access to the PureResponse system. If you do not have these details, please contact your Business Development 
Manager or Account Manager to arrange for these to be provided to you.

The PureResponse platform provides additional data that allows for more technology-centric data segmentation. This is 
invaluable as a marketing dataset. The ADDITIONALCOLUMNNAMES section can be used to return this information, i.e. 
device type, device OS and device browser are extra fields that can be imported into your Response database. Contact 
your Pure360 Account Manager or the Pure360 support desk for further information on these extra data fields and how 
they can be used to help you market your campaigns more effectively.

With this additional information provided by the PureResponse platform, you can then retarget those who have, for 
example, opened their emails on mobile devices and optimise the layouts or content based on this information. You may 
have a product that has a specific benefit to those whose lifestyle is suggested to be more mobile-centric, and update them 
on this via a separate campaign. You can use the Decision Tree module within the Discoverer application to consciously 
segregate data into these different channels and allow for different campaigns to take place on this basis.
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INSTALLING THE EMAIL RESPONSE WEB SERVICE

You will find the Email Response Web Service application installation package in the same DigitalIntegration.zip file provided 
with FastStats. This can be downloaded from the Downloads Area to a folder on the server where the Email Response Web 
Service will be installed on. Note: It is recommended to run the Installation file from an account with LocalAdministrator 
privilege to ensure that you have the necessary rights to complete the installation. 

Extract the file EmailResponseWebServiceSetup.msi file from the DigitalIntegration\ EmailResponseGatherer folder. Launch 
the software by double clicking on it.

Click the Next> button. On the following screen, choose 
the Site to install this to using the dropdown list provided. 
Choose a meaningful Virtual Directory name and type 
that into the appropriate box. Now select an appropriate 
Application pool from the dropdown list provided and 
click the Next> Button.

Note: You probably will only need to provide a Virtual 
Directory name, but you should confirm that this is
the case.
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Click on the Next> button to confirm the settings and the installation will progress, installing the requisite files to create the 
Email Response Web Service.

On completion you are presented with the following screen. 
click the Next> Button.

The installation has now completed, so click on the 
Close button.
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CONFIGURING THE EMAIL RESPONSE WEB SERVICE

We now need to configure the Email Response Web Service to use your Response Database. To ensure that this is done, 
run the FastStats Configuration program. Click on the File menu option and select Configure Pure360 Response… from the 
options presented.

In the dialog box click the File menu and select Open then 
browse to the location of your web.config file for the Email 
Response Web Service. This will normally be found at
C:\inetpub\wwwroot\EmailResponse\web.config.

In the dialogue box shown, type in the SQL 
Server connection string for your Response Database. 
Additionally you will need to provide a location for a 
Log file in the Text Box. Alternatively you could click the 
Browse button and navigate to the folder you would 

like and type a file name in.

Click Save from the File menu.

You will need to make sure that your Web Server can talk 
to your Database server. As we are not familiar with your 
infrastructure, we cannot help with this, but as an example, 
you may need to:

Open up specific gateways in your firewall to 
allow access

Configure your Active Directory to allow for 
relevant permissions for access

Other security related procedures and tasks
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CONFIGURE THE EMAIL BROADCASTER

You now need to configure Pure360 as your Email Broadcaster. 
This is done in the FastStats Configuration program. 
To do this, click the FastStats Services button.

As you can see from the screen below, there are a series of 
tabs across the top, and you need to click on the tab relating 
to the system you are looking to integrate with the 
PureResponse platform.

 
In the column of options on the left, select Email Broadcaster, 
and then in the Right-hand pane, choose Pure360 from the 
Email Broadcaster dropdown list. You will need to enter the 
Database Connection String (Email Response) string, or 
check the Use Global Database Connection String tickbox 
(although this method is less secure).  Don’t forget to Test 
your connection to ensure that the connection will in fact 
work as expected.

Note: You may need to restart the FastStats service for these 
changes to take effect. For information on how to do this, 
check your FastStats documentation.

SECURITY CONSIDERATIONS

Do not forget that you will have to allow access to resources specified below to ensure that Broadcasts and Campaigns can 
work fully. You should allow bi-directional access (inbound and outbound) on port 80 for the following URLs:

User login = paint.pure360.com

Data exchange = response.pure360.com

PURE360 CONFIGURATION

Using the PureResponse platform you now setup an email message which can be referred to in your Email Broadcasting 
wizard or in your Cascade configuration.

To create an email message, logon to your Pure360 account using the profile that you will use within FastStats.

To start, click on content, then select the new email option.

Using the email editor, create a message, save it, and make a note of the message name, unless you are using 
Personalisation fields sent over from FastStats. All data fields that you have sent over in the list will be available 
for Personalisation (e.g. {~firstName~}, {~industry~}, etc.)

You need to make Pure360 aware of which Email Response collection method that you have enabled. Pure360 will enable 
Event Notifications on the system and will customise this based on the method you have selected. 
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If you selected the Email Response Web Service you need to notify them of the response types that you want back from 
them and the URL to which you would like them delivered. You should provide the full URL, for example:

http://www.mydomain.com/Response/ResponseCollector.aspx

The following responses are collected by the Email Response Web Service collector:

OPEN:  Generated by a customer opening an email
CLICK:  Generated by a link being clicked within an email
BOUNCE: Generated when an email cannot be delivered to a customer
OPT-IN:  Generated by a customer opting in to one of your lists
OPT-OUT: Generated by a customer unsubscribing using the link in your email

All of these response types help you market to your customer base because you now have a greater understanding of how 
the communications are received and what your customer interaction with these are.

For example you may be sending a message out that has three distinct options within these for people to click on. Based on 
the CLICK responses back, you could separate these out into three channels for specific follow-up campaigns using the clicked 
URLs to determine which respondents have regarded which element as more important than the other(s).

Using the Email Broadcasting Wizard with the PureResponse platform

The Email Broadcasting wizard plugin needs to be enabled within the Discoverer configuration in order for it to be used.

Launch the Discoverer Configurator application and open 
your Discoverer.exe.config file by clicking the File menu 
item and selecting Open. Click on the Plugins tab and 
enable the Broadcasting Wizard by placing a tick next 
to Apteco.Discoverer.Plugins.EmailBroadcasting. Save the 
configuration by clicking on the File menu item and selecting 
Save, then exit the utility. 

Launch the Discoverer application and select Users Explorer. 
In Users Explorer, right-click on an entity in the Name section 
and click on Modify on the menu presented, then click on 
Modify Plugin Configurations...
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The Modify Plugin Configurations dialog box is 
now presented.

We need to make a few changes here: Un-tick 
the Inherit for Email Broadcasting (User Defined
Fields) plugin item and then click on the Edit... 
button next to it. The Email Broadcasting 
dialogue box is now displayed.

We need to add the template from the email we created 
earlier in the PureResponse platform. Click on the Add... 
button to add a new template for the wizard to use.



13www.pure360.com

FastStats Integration
Guide

The Edit Template dialog box is now displayed. In the Name 
box, type in a name for the template, select the appropriate 
Resolve Table from the dropdown and ensure that Pure360 
is selected as the Email Broadcasting Provider in that 
dropdown as well. If you are using a secure connection 
to Pure360 (sometimes referred to as an https connection) 
ensure the Secure? tickbox is checked.

If there are additional parameters you need to pass, tick 
the Set Parameters Manually box and add these in here 
(for example UseDatedList=true allows for Unique mailing 
lists by timestamping the name of the mailing list uploaded 
to the PureResponse platform). Finally, if you need (or want) 
to, provide a description for this template in the Description 
box. When you have made all the changes you need, click 
the OK button.

You will need to exit out of the Discoverer application and 
log back in again for these changes to take effect.

The Email Broadcasting Wizard can be used in many ways. 
You can open the wizard first and drag a saved data grid 
into the window, or you can create a data grid and launch 
the Email Broadcasting Wizard from there. Here is an 
example of this in action.

Using whatever selection criteria you need, create a 
Data Grid. This grid must contain either an email address 
or a mobile number. Records containing neither of these 
will not be uploaded to the PureResponse platform as one 
or both of these are needed to conduct campaigns. 

Again, as an example, using the CLICK responses, you could 
create an email with Dynamic blocks inside that are selected 
based on the recipients’ previous click history. Should no such 
history exist within FastStats, you can elect to show default 
blocks of content. This could mean a campaign goes out showing a new line of products that have been 
introduced by your company, and those that have already clicked on this line could be shown specific products 
from the line based on their historical interaction with your company. The obvious benefit is that the message 
is now more targeted to the individual and they receive a communication that is far more likely to engage them 
with your company’s offerings.

Note: We do not recommend using Data Grouping as this 
is not supported within the PureResponse platform.

To start the Email Broadcasting Wizard, click on the
Envelope icon on the Toolbar. This will bring up the 
following dialog box.
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Depending on whether you have multiple defined templates 
or not, you may either start on this Stage or Stage 3 (if there 
is only one template on the system). Assuming you are at 
Stage 1, select the template to be used from the dropdown 
list and click the Next button.

The Dialog box for Stage 3 is shown above. In 
each appropriate dropdown box select a field to 
match either the field containing the email address 
to be sent to or the mobile phone number and 
click the Next button.

Stage 4 requires you to review the additional fields that will 
be sent as part of the list. Tick or untick the data fields you 
wish sent over. Your previous selections for email/SMS will be 
greyed out on this screen. Once you are satisfied with these 
click the Next button.

You now need to enter the Username and Profile 
Name in the Username box, and provide the 
password in the Password box to allow for 
access to your Pure360 account.

Clicking the retrieve button in the List Name box (the circular 
anticlockwise arrow) will fetch all the current List Names. 
From the list presented select one from the dropdown 
menu or enter a new List Name.  Any existing lists will be 
appended to unless the Overwrite an existing list check 
box is ticked. 

Similarly, clicking the retrieve button for Message Name will 
fetch all the current Message Names. Select one of these 
from the dropdown or leave it blank if you just want your 
list Created, Replaced or Appended to.
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Use the Browse… button to navigate to a folder where you would like to store the generated list, and type in a valid email 
address to receive notification once the list has been uploaded. Click the Next button to continue.

Note: If your Pure360 account has multiple profiles configured, you can access these by specifying the profile with the 
account in the wizard. In our example above, we are logging into the apteco.system account in the PureResponse platform 
and addressing the profile called apteco.dev. As you can see, Usernames and profiles should be separated by a \ character.

The completed dialog box is now shown indicating that the 
list has been uploaded and the message delivery has been 
scheduled the wizard will complete. Click the Finish button 
to close the wizard.

Using this process, you can create targeted relevant 
campaigns based on criteria you pre-select which will 
result in more efficient communication between you and 
your customer base. If for example, your company supplies 
lightbulbs for cars and you have recorded the currently 
owned vehicle in your customer data, where that field is 
populated, you can create the body of the email such that it 
reflects the customer’s stated vehicle and shows them items 
relevant to that make or model of car.

Using the Email Responses wizard

Once an email broadcast has started, Event Notifications begin being collected by the PureResponse platform. Using the 
Email Responses wizard, you can begin analysing responses from the recipients of your campaign.

Open the Email Responses wizard.

Please enter the message name you used in the Email 
Broadcasting wizard, then click the Next button.

Once Event Notifications start being collected by your web 
service you will see how customers are interacting with your 
broadcast. If you want to further analyse this information, 
tick the Create a virtual variable from this information 
box and then click the Next button.
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You will need to drag the Email or SMS variable that you used 
in the Email Broadcasting wizard into the drop box and click 
the Next button.

Use the Browse… button to navigate to a folder 
where you would like to store the virtual variable 
data and click the Next button.

If you would like to enter any notes to be stored along with 
the virtual variable, type these into the box provided and 
click the Next button.

You should now enter a Description for the virtual variable 
data. Alternatively you can drag an existing virtual variable 
onto the drop box if you wish to overwrite this.  If you tick
the Modify Security Attributes the next screen allows you 
to define who will have access to this virtual variable data 
and what permissions they have with respect to it. If you 
do not need to do this, simply click the Next button.
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The data returned in the form of Event Notifications from the PureResponse platform can be used for many purposes, 
from reporting for marketing, for finance and for manufacturing, to re-engaging the customers in new or further campaigns 
and enables a greater understanding from a marketing perspective of your customer base. You may have a reasonable 
understanding of what is important to your customer base but even a few percentage points of difference between 
estimated and actual values can represent a huge saving to any organisation.

The marketer has multiple channels available to them. FastStats holds all your data and so helps to understand the status 
of all your email addresses (for example,  bounces allows you to understand when another channel might be a better mode 
of communication, thereby reducing your direct mail spend by only contacting when your recipients have specified to be 
contacted in this manner, bounced or opted out).  All of this becomes a simple query that you can run in FastStats with the 
PureResponse FastStats integration. This is a major value-added benefit to the Integration and allows for more accurate 
budgeting which is targeted to meet specific market needs.

Using Cascade with the PureResponse platform

To ensure that you can use Cascade with the PureResponse 
platform, you must first configure the system. This will involve 
defining an Output Sequence, followed by configuring the 
Broadcast settings to use the PureResponse Platform and 
the defined Output Sequence.

Here is how this is done. In the Discoverer application from 
the menu, select Tools, Administrative Functions, Setup 
Broadcasting Fields... Click on Add New Broadcasting 
Field and then update the information in the 
Dialog box presented. 
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Ensure that the Set Name is the same for each variable and source code. At least one variable needs to be set as the Email or 
SMS field in use. Add every field that you are using in Cascade from your selected dataset.

Once this process has been completed, we need to 
configure the Broadcast Settings. To do this, once again 
in the Discoverer application, you need to click on Tools, 
Administrative functions. This time, however, select 
Cascade, and Modify Broadcast Settings...

Click on the Add New Cascade Broadcast and then complete 
the Dialog box presented with your credentials for accessing
 the PureResponse platform.

The Name field can be used to describe the sequence you 
are creating. Your Username and Profile must be provided, 
separated as before with the \ character. Enter your 
Password which will authenticate you in the PureResponse 
platform. The Sequence dropdown should be set to match 
the Broadcasting Field that you created earlier from the 
Sequence dropdown list.

The Confirmation Email Address field should be set up with 
an email address to receive notification once the list has been 
uploaded to the PureResponse platform.

Note: If your Pure360 account has multiple profiles 
configured, you can access these by specifying the profile 
with the account in the wizard. In our example above, we are 
logging into the apteco.system account in the PureResponse 
platform and addressing the profile called apteco.dev. As you 
can see, Usernames and profiles should be separated by 
a \ character.
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Now we need to provide Cascade with the MetaDatum called 
EmailMessage so that it understands how to attribute this to 
the campaign. To do this, in the Discoverer application again, 
click on Tools, Administrative Functions, Cascade, Modify 
Attributes and then click on Add Cascade MetaDatum.

In the dialog box presented, we need to enter EmailMessage 
in the Name field and EmailMessage in the Description field. 
From the dropdown lists selected choose the appropriate 
entries for Table where the campaign meta-information will 
be stored, and the Type of campaign (in this case, Broadcast). 
Leave the other options as they currently are and click the OK 
button to store this information.

Your email broadcast can now be configured to run at 
Promotion, Cell or Pack level. To do this, open your promotion 
and then click on the Outputs option on the Information tab. 
The following dialog box is shown.

Tick the Email Broadcast checkbox and select your chosen 
configuration from the dropdown list of available broadcasts. 
To have the list uploaded and sent automatically, enter a 
Message Name of apre-existing valid message that you have 
already created within the PureResponse platform.

Once the promotion is created, either manually or as part 
of a scheduled job, individual packs are uploaded to lists 
with the same nameas the individual pack names. These 
lists contain the same variables defined in your broadcasting 
fields set. If a message name was included a campaign will 
be scheduled within the PureResponse platform. However, 
if this is not defined, you can login to the PureResponse 
platform and configure and schedule the campaign via 
the interface there.

This enables you to target multiple lists at the same time. 
The benefits are many, but key amongst these is that you can 
target multiple markets within the same email campaign to 
ensure the highest level of interaction. This is particularly 
appropriate if you have a generic campaign for engaging or 
re-engaging interest, which may be of interest to more than 
one customer segment, and allows you to address many 
market bases simultaneously, with near-instant metrics on 
the success (or otherwise) of the campaign being conducted.

Note: Pack files can be collated into one custom file by selecting Custom Files and providing a name for them. This will then 
be sent as a list to the PureResponse platform.
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Similar to the Email Responses Wizard, within the Cascade 
application you can create a digital responses virtual variable 
by clicking the Create Digital Responses Variable icon which 
will generate an Email Responses to xyz Promotion virtual 
variable in your Others folder.

Again, the information returned by the PureResponse platform works best when you feed the results of this campaign back 
into FastStats and use this to retarget your market base. For example, a generic campaign may show a specific interest in one 
particular aspect of your business that you wish to promote. Knowing that this is something that is popular with your market 
base, gives greater leverage and better justification on investing in campaigns that target this specific new behaviour within 
your customer marketplace.


